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List of Experiments 
 
 

S.No. Name of Experiment By RGPV Page No. 
1. Installation and configuration of Hadoop/Euceliptus etc.  
2. Service deployment & Usage over cloud.  
3. Management of cloud resources.  
4. Using existing cloud characteristics & Service models .  
5. Cloud Security Management.  
6. Performance evaluation of services over cloud .  

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
List of Experiments 

 

 

S.No. Name of Experiment Plan by Me Page No. 
1. Working of Goggle Drive to make spreadsheet and notes.  
2. Installation and Configuration of Justcloud.  
3. Working in Cloud9 to demonstrate different language.  
4. Working in Codenvy to demonstrate Provisioning and Scaling of a website.  
5. Installation and Configuration of Hadoop/Eucalyptus  
6.  Working  and installation of  Google App Engine  
7. Working  and installation of  Microsoft Azure  
8. Working with Mangrasoft Aneka Software  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment No. 1 
 

Objective: Working of Goggle Drive to make spreadsheet and notes. 

  

Requirement: Google account, Internet Connection. 

 

THEORY: 

 
Google Docs is a free cloud-based suite of tools for creating documents, spreadsheets, presentations, and 

more. This tutorial will cover the Spreadsheets application in Google Docs, in addition to showing you how 

to access and store your Docs from Google Drive. 

Google Docs, Sheets, and Slides are productivity apps that let you create different kinds of online documents, 

work on them in real time with other people, and store them in your Google Drive online — all for free. You 

can access the documents, spreadsheets, and presentations you create from any computer, anywhere in the 

world. (There's even some work you can do without an Internet connection!) This guide will give you a quick 

overview of the many things that you can do with Google Docs, Sheets, and Slides. 

Google Docs 

Google Docs is an online word processor that lets you create and format text documents and collaborate with 

other people in real time. Here's what you can do with Google Docs: 

 Upload a Word document and convert it to a Google document 

 Add flair and formatting to your documents by adjusting margins, spacing, fonts, and colors — all that 

fun stuff 

 Invite other people to collaborate on a document with you, giving them edit, comment or view access 

 Collaborate online in real time and chat with other collaborators — right from inside the document 

 View your document's revision history and roll back to any previous version 

 Download a Google document to your desktop as a Word, OpenOffice, RTF, PDF, HTML or zip file 

 Translate a document to a different language 

 Email your documents to other people as attachments 

Google Sheets 

Google Sheets is an online spreadsheet app that lets you create and format spreadsheets and simultaneously 

work with other people. Here's what you can do with Google Sheets: 

 Import and convert Excel, .csv, .txt and .ods formatted data to a Google spreadsheet 

 Export Excel, .csv, .txt and .ods formatted data, as well as PDF and HTML files 

 Use formula editing to perform calculations on your data, and use formatting make it look the way 

you'd like 

 Chat in real time with others who are editing your spreadsheet 

 Create charts with your data 

 Embed a spreadsheet — or individual sheets of your spreadsheet — on your blog or website 



Google Slides 

Google Slides is an online presentations app that allows you to show off your work in a visual way. Here's 

what you can do with Google Slides: 

 Create and edit presentations 

 Edit a presentation with friends or coworkers, and share it with others effortlessly 

 Import .pptx and .pps files and convert them to Google presentations 

 Download your presentations as a PDF, a PPT, or a .txt file 

 Insert images and videos into your presentation 

 Publish and embed your presentations in a website 

Create, name or delete a Google document 

Create a Google document 

To create a new document, go to your Drive, click the Create button, and select Document. 

A window with a new Google document will open, and you'll be able to edit the document, share it with other 

people, and collaborate on it in real-time. Google Docs saves your document automatically, and you can 

always access it from your Drive. 

Name a document 

When you create a new document, Google Docs will name it Untitled by default.  

To choose a name other than Untitled, click the File menu, and select Rename. From here you can choose 

and confirm your document's title. You can also edit the name by clicking the title displayed at the top of the 

page, and making your changes in the dialog that appears. Titles can be up to 255 characters long. 

Delete a document 

Delete an item that you own from your Drive 

1. From your Drive, select the item(s) you want to delete. 

2. From the More menu, choose Move to trash. 

3. If you're deleting a shared document that you own, you'll see an option to change the ownership of the 

document. 

4. The item will be moved to the Trash. 

5. To purge individual items from Trash, select them and choose Delete forever. To purge all your items 

click Empty Trash in the upper left. 



Create and save a document 

There are different ways of getting started using Google documents: you can create a new online document, 

you can upload an existing one, or you can use a template from our templates gallery. 

To create a new document, go to your Drive, click the red Create button, and select Document from the 

drop-down menu. 

As soon as you name the document or start typing, Google Docs will automatically save your work every few 

seconds. At the top of the document, you'll see text that indicates when your document was last saved. You 

can access your document at any time by opening your Drive at http://drive.google.com. 

To save a copy of a document to your computer, you can download it. In your document, go to the File menu 

and point your mouse to the Download as option. Select one of the following file types: HTML (zipped), 

RTF, Word, Open Office, PDF, and plain text. Your document will download to your computer. 

Upload a document 

You can upload existing documents to Google documents at any time. When you're uploading, you can either 

keep your document in its original file type or convert it to Google Docs format. Converting your document to 

Google Docs format allows you to edit and collaborate online from any computer. 

Note: When uploaded, images within a document are left as images (rather than being converted to text by 

Optical Character Recognition technology). 

You can upload the following file types: 

 .html 

 .txt 

 .odt 

 .rtf 

 .doc and .docx 

 .pdf 

Follow these steps to upload a document: 

1. Click the Upload icon in the top left of your Documents List. 

2. Click Files..., and select the document you'd like to upload. 

3. Click Open. 

4. Check the box next to 'Convert documents, presentations, spreadsheets, and drawings to the 

corresponding Google Docs format' if you'd like to be able to edit and collaborate on the document 

online. Uploaded document files that are converted to Google documents format can't be larger than 1 

MB. 

5. Click Start upload. The uploaded file will appear in your Documents List. 

 



Experiment No. 2 
 

Objective: Installation and Configuration of Justcloud. 

  

Requirement: Justcloud exe File 

 

THEORY: 

 
Professional Cloud Storage from JustCloud is Simple, Fast and Secure. 

Just Cloud will automatically backup the documents, photos, music and videos 

stored on your computer, to the cloud so you are never without files again. 

 

Installation :  

 

1. Download Software this link 

http://www.justcloud.com/download/ 

 
 

2. By following these steps you will download and install the JustCloud software application on this 

computer. This software will automatically start backing up files from your computer and saving them 

securely in an online cloud user account. Your free account gives you 15MB storage space or 50 files 

for 14 days. Once installed a sync folder will be added to your desktop for you to easily drag and drop 

files you wish to backup. 
 



Experiment No. 3 
 

Objective: Working in Cloud9 to demonstrate different language.  

 

Requirement: Login account in Cloud9 

 

THEORY: 

 
Cloud9 IDE is an online development environment for JavaScript and Node.js applications as well as HTML, 

CSS, PHP, Java, Ruby and 23 other languages. Anyone looking for a modern and secure IDE. With your code 

online and accessible from anywhere, you can work more efficiently than before. 

Creating a new account 

Creating an account for the Cloud 9 IDE can be done in a few simple steps: 

1. First, sign up for an account on the Cloud9 homepage, by filling in your desired username and email 

address and pressing the Sign me up button: 

 

You will then see a message indicating that we have sent you an email to the address you provided with 

activation instructions: 



 

2. Check your email now. You will receive an email from us with a link to activate the account. Click on the 

link. You will now be asked to set a password for your new Cloud9 account: 

 

  

3. Click on Activate.  



Congratulations! You are now the proud owner of a Cloud9 account. Now, go ahead and create your first 

project. 

Create a new project 

The first step for creating a new project is to click on the "+" next to My Projects in the Projects tab: 

 

  

At this point, you will encounter two choices: Create a new project and Clone from url. We will explore 

both paths. 

 After clicking on Create a new project, you will be presented with the screen shown below: 

 

  

Enter a project name. You will now have three choices for the type of project you wish to create: 

 Git project: will allow you to run git commands from the console and push your changes to Github 

 Mercurial: will allow you to run hg commands form the console and push your changes to Bitbucket. 

 FTP: will allow you to upload your files directly to an FTP server you have access to. 



Make a choice for the type of project and press Create. That is all! You will now see your new project in the 

dashboard: 

 

Now, just click Start Editing to get started!  

Let's start with a simple "Hello Cloud9" example.  

1. From your dashboard, click 'create new workspace' and then select 'create new workspace'. 

2. Enter a catchy workspace name, visibility: open (proud to share your creations), hosting: hosted and 

choose a 'custom' workspace type. Click 'create'. 

3. The workspace is being prepared and when done, select the project in the dashboard and click 'start 

editing'. 

4. The workspace is opened, right click the project tree and select 'new file'. Name it 'helloCloud9.cc'. 

5. Open the file by double clicking it in the file tree. Copy / paste the following code in the file:  

int main() { 

  

 cout << "Hello world\n"; 

  

} 

6. Compile the code using:  

g++ helloCloud9.cc -o helloCloud9 

7. Run the file by typing:  

./helloWorld 

 

 

 
 

 

 



Experiment No. 4 
 

Objective: Working in Codenvy to demonstrate Provisioning and Scaling of a website. 

 

Requirement: Login account in Codenvy, Cloud Bees. 

 

THEORY: 

PaaS Overview 

 

 

 

One of the advantages of coding in the cloud with Codenvy is deploying to a PaaS of choice once the app has 

been built, run and tested in Codenvy. Users do not need to install any plugins or administer their workspaces 

in any way. Codenvy talks to API of most popular PaaS providers. Currently, the following PaaS are 

supported: 

 AppFog 

 CloudBees 

 AWS Elastic Beanstalk 

 Google App Engine 

 Heroku 

 Openshift 

 ManyMo (to run Android apps) 

The mechanism of deploying, updating and configuring apps slightly differs depending on the chosen PaaS 

provider. To be able to deploy to a PaaS authentication is required (Login or Switch Account in PaaS 

menus). Codenvy will handle connection to a PaaS account, retrieving information on existing apps and 

providing tools to manage them. 

Some providers will require deploy of SSH keys and git operations to update the apps (Heroku, OpenShift), 

while others (GAE, AWS) make it possible to update apps in one click. 



When deploying an application, it is created in Codenvy and then deployed to a PaaS. OpenShift is an 

exception from this rule – the application is created there and then pulled to a Codenvy workspace. 

It is possible to import existing apps deployed to some PaaS (Heroku) or overwrite existing applications 

(Google App Engine). 

You can find detailed how-to guides on how to get started with PaaS in Codenvy in a PaaS menu on the left 

sidebar. Check out PaaS support chart: 

PaaS Languages Features 
Cloud SDK 

Run 

 

Java 
Application management 

EC2 and S3 console 
Yes 

 

Java, PHP, Python, Ruby Manage applications No 

 

Java, Ruby  Manage applications 
Yes - Micro 

Cloud Foundry 

 

Java Manage applications No 

 

Java 

Python 

PHP (app IDs need to be 

whitelisted at GAE) 

Application management, Logs, Indexes, Pagespeed, 

Queues, DoS, Resource Limits, Crons, Backends 
Yes 

 

Ruby 
Manage applications No 

 

Java, PHP, Ruby, Python, 

Node.js 
Manage applications No 

 

Java, Ruby Manage applications 
 

 

Registration and Login 

There are several registration options available in Codenvy: 

 The fastest and the easiest way is to register using your Google or GitHub account. Click Sign in with 

Google or GitHub and follow the registration process. Your Codenvy workspace name will be 

identical to your Google or GitHub ID. Note that you will need a verified email associated with your 

GitHub account. 

http://aws.amazon.com/elasticbeanstalk/
https://www.appfog.com/
http://www.cloudfoundry.com/
http://www.cloudbees.com/
https://developers.google.com/appengine/
https://www.heroku.com/
https://www.openshift.com/
http://www.tier3.com/products/services/web-fabric


 If you do not have accounts with Gmail or GitHub or just want to choose a domain name by yourself, 

enter your email and the desired domain name, and press Go. 

 

Getting Started Using Codenvy Factories 

You can find Codenvy Factorybuttons at his site, Сodenvy.com or anywhere on the net. If you click on a 

Factory button, we will create a temporary workspace for you with the project of your choice. After a fruitful 

coding session in a temporary workspace you can create a permanent account with Codenvy by pressing 

Create Account button in the top right corner of a temporary workspace. 

Create a Project from Scratch 

Once logged in to Codenvy, the Welcome Screen and Get Started Wizard will help you make your first 

steps. If this is your first visit to Codenvy and you do not have any created projects, you will see the below 

window. Creation of a new project will barely take 1-2 minutes, and the wizard will guide your through each 

step (entering project name, choosing a technology and PaaS). 

 

You can also create a new project from the Welcome Screen - Create a New Project From Scratch 



 

 

 

A Smart Wizard will guide you through the process of creating your project. You need to choose 

a Technology and the supported PaaS in case you want to deploy your application. Each technology is tied up 

with the supported PaaS, thus, making your choice error-free. 

 To complete a project creation procedure, choose a Template (there are several templates to choose 

from, depending on the chosen technology and PaaS). 

 

http://docs.codenvy.com/wp-content/uploads/createproject.png
http://docs.codenvy.com/wp-content/uploads/createproject.png
http://docs.codenvy.com/wp-content/uploads/wizard.png
http://docs.codenvy.com/wp-content/uploads/wizard.png


The next stages depend on whether or not you want to deploy your application to PaaS right way, and what 

PaaS you have chosen. 

Please, have a quick look at the video demonstrating a new user friendly Create a Project Wizard. 

Import GitHub Projects 

Importing a project from GitHub will create a new project and by clone the content of a GitHub repository. 

You will find a GitHub import option on the Welcome Screen 

 

 Click OK to go to a GitHub authorization page. 

 authorize the app 

 

 Choose the repository you want to import (check Git Read-Only if necessary) and click Finish 

 



Device Support 

Codenvy currently supports all desktop and laptop devices. We currently provide touch device support 

through the use of the Puffin Web Browser which virtualizes double clicks and right clicks.  We have not yet 

created a native touch UI design.  

Browser Support 

Browser Version 

Chrome 

 

21+ 

Firefox 

 

15+ 

Safari 

 

5.1+ 

Puffin Browser 

 

2.4+ 

 

Web Server Support 

Web Server Version 

Apache Tomcat 

 

7.0.39 

 

Build Environment Support 

Build System Version 

 

3.0.4 

 

Version Control System Support 

Version Control System Version 

 

1.6 

https://www.google.com/intl/en/chrome/browser/
http://www.mozilla.org/en-US/firefox/new/
http://www.apple.com/safari/
http://www.puffinbrowser.com/
http://tomcat.apache.org/
http://maven.apache.org/
http://git-scm.com/


Git Hosting Provider Support 

Provider Homepage Tutorial Link 

Assembla https://www.assembla.com/  Assembla 

Beanstalk http://beanstalkapp.com/  Beanstalk 

BitBucket https://bitbucket.org/  BitBucket  

CloudForge http://www.cloudforge.com/  CloudForge  

Codebase http://www.codebasehq.com/  Codebase  

Codeplane https://codeplane.com/  Codeplane  

Codespaces http://www.codespaces.com/  Codespaces  

Deveo https://deveo.com/  Deveo  

GitEnterprise http://www.gitenterprise.com/  GitEnterprise  

GitHub https://github.com/ GitHub 

GitLab http://gitlab.com/  GitLab  

Gitorious https://gitorious.org/  Gitorious 

PHPCloud http://www.phpcloud.com/  PHPCloud 

PikaCode https://pikacode.com/  PikaCode 

Planio https://plan.io/ Planio 

ProjectLocker http://projectlocker.com/  ProjectLocker  

Unfuddle https://unfuddle.com/ Unfuddle  

Language Support 

Language Version 
Syntax 

coloring 

Code 

outline 

Code 

assistant 

Error 

detection 

Cloud 

local run 

Debug 

mode 

 

2.0 Yes No Yes No Preview ----- 

 

4.1 Yes Yes Yes Yes Preview ----- 

 

1.6 (runner and autocomplete) Yes Yes Yes Yes Yes Yes 

JavaScript 

 

Standard ECMA-262 Yes Yes Yes Yes No No 

 

5.3 Yes Yes No No Yes No 

 

2.7 (for runner only) Yes No No No Yes No 

 

1.9.2 Yes Yes Yes No No No 

https://www.assembla.com/
http://docs.codenvy.com/docs/integration-with-assembla/
http://beanstalkapp.com/
http://docs.codenvy.com/tutorials/integration-with-beanstalk/
https://bitbucket.org/
http://docs.codenvy.com/docs/integration-with-bitbucket/
http://www.cloudforge.com/
http://docs.codenvy.com/tutorials/integration-with-cloudforge/
http://www.codebasehq.com/
http://docs.codenvy.com/docs/integration-with-codebase/
https://codeplane.com/
http://docs.codenvy.com/tutorials/integration-with-codeplane/
http://www.codespaces.com/
http://docs.codenvy.com/tutorials/integration-with-codespaces/
https://deveo.com/
http://docs.codenvy.com/tutorials/integration-with-deveo/
http://www.gitenterprise.com/
http://docs.codenvy.com/tutorials/integration-with-gitenterprise/
https://github.com/
http://docs.codenvy.com/docs/integration-with-github/
http://gitlab.com/
http://docs.codenvy.com/tutorials/integration-with-gitlab/
https://gitorious.org/
http://docs.codenvy.com/tutorials/integration-with-gitorious/
http://www.phpcloud.com/
http://docs.codenvy.com/tutorials/integration-with-phpcloud/
https://pikacode.com/
http://docs.codenvy.com/tutorials/integration-with-pikacode/
https://plan.io/
http://docs.codenvy.com/tutorials/integration-with-planio/
http://projectlocker.com/
http://docs.codenvy.com/tutorials/integration-with-projectlocker/
https://unfuddle.com/
http://docs.codenvy.com/tutorials/integration-with-unfuddle/
http://www.w3.org/Style/CSS/Overview.en.html
http://www.w3.org/MarkUp/
http://www.oracle.com/technetwork/java/javase/overview/index.html
https://developer.mozilla.org/en-US/docs/Web/JavaScript?redirectlocale=en-US&redirectslug=JavaScript
http://php.net/
http://www.python.org/
http://www.ruby-lang.org/


Language Version 
Syntax 

coloring 

Code 

outline 

Code 

assistant 

Error 

detection 

Cloud 

local run 

Debug 

mode 

 

1.0 Yes Yes Yes Yes ----- ----- 

Framework Support 

Framework Version Access Templates 

 

 
Project 1) Simple Android application 

 

2.1 Project 

1) Google App Engine Java project that uses the Search API 

2) Java Web project 

3) A demonstration of accessing Amazon S3 buckets and objects using the 

AWS Java SDK 

 

0.4.12  Project 1) Simple Node.js project 

 

1.8 Project 
1) Simple Ruby on Rails application. v1.9 

2) Simple Ruby on Rails application. v1.8 (Heroku compatible) 

 

All 

versions 
Project 

1) Simple Spring application 

2) Spring MVC application with AJAX usage 

PaaS Support 

PaaS Languages Features 
Cloud SDK 

Run 

 

Java 
Application management 

EC2 and S3 console 
Yes 

 

Java, PHP, Python, Ruby Manage applications No 

 

Java, Ruby  Manage applications 
Yes - Micro 

Cloud Foundry 

 

Java Manage applications No 

 

Java 

Python 

PHP (app IDs need to be 

whitelisted at GAE) 

Application management, Logs, Indexes, Pagespeed, 

Queues, DoS, Resource Limits, Crons, Backends 
Yes 

 

Ruby 
Manage applications No 

http://www.w3.org/XML/
http://developer.android.com/index.html
http://www.oracle.com/technetwork/java/javaee/jsp/index.html
http://nodejs.org/
http://rubyonrails.org/
http://www.springsource.org/
http://aws.amazon.com/elasticbeanstalk/
https://www.appfog.com/
http://www.cloudfoundry.com/
http://www.cloudbees.com/
https://developers.google.com/appengine/
https://www.heroku.com/


PaaS Languages Features 
Cloud SDK 

Run 

 

Java, PHP, Ruby, Python, 

Node.js 
Manage applications No 

 

Java, Ruby Manage applications 
 

 

URL Format for Workspaces, Projects and Files 

Every Codenvy user has a domain, also called a workspace. 

https://codenvy.com/ide/[workspace name] 

Each workspace contains projects that also have their urls: 

https://codenvy.com/ide/[workspace name]/[project name] 

While projects have their files: 

https://codenvy.com/ide/[workspace name]/[project name]/[file name] 

However, these URL are not displayed in a browser’s address bar. In other words, even if you go to 

codenvy.com/ide/workspace/project/file 

codenvy.com/ide/workspace/ 

although the target file will be opened. The same concerns project URL. 

Before July 9, 2013, domain names were added as subdomains to codenvy.com, e.g. 

https://johnsmith.codenvy.com  

Such an address will be automatically redirected to  

https://codenvy.com/ide/johnsmith  

 

 

 

https://www.openshift.com/
http://www.tier3.com/products/services/web-fabric
https://johnsmith.codenvy.com/
https://codenvy.com/ide/johnsmith


Architecture 

 

Index Explanation 

a 
The client’s browser loads Codenvy site and makes a request. There are two basic types of client 

requests: regular (business logic) and meta 

b The request is recognized as a regular and load balancer (HAProxy) routes it accordingly  

c 
Request is recognized as meta, so Cloud Admin performs some special actions like tenant 

creating/removing 

d While performing meta request Cloud Admin may change the configuration of HAProxy 

e 
Business request is routed to the IDE Application dynamically deployed on one of the Application 

Servers 

f 

While performing meta request Cloud Admin may use internal REST request to the Cloud Agent 

located on one of the Application Servers with IDE Application or create/remove AS according to 

scalability rules 

g 
Some kinds of meta requests, such as Authentication, call Organization DB located on LDAP server 

and containing information about Users, Workspaces and other business entities 

http://docs.codenvy.com/wp-content/uploads/architecture_diagram.png
http://docs.codenvy.com/wp-content/uploads/architecture_diagram.png


Index Explanation 

h IDE calls Organization DB 

i IDE calls internal services - Builder (for Java apps) 

j IDE calls internal services - Testers (Debuggers) (for Java apps) 

k IDE uses a Distributed Storage (GlusterFS) via Virtual File System interface 

l IDE calls external PaaSes/Storages and VCSes REST API 

m Statistics storage retrieves logs from the applications for further analysis 

n Request to the Cloud Admin impacts service’s statistical information stored in Hadoop Cluster 

o Administrative client manages Cloud Admin 

p Manager requests Statistical storage for service metrics through a dedicated Administrative client 

q IDE calls internal services - Code Assistants 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment No. 5 
 

Objective: Installation and Configuration of Hadoop/Eucalyptus. 

Requirement: . Java 1.6, Eclipse Europa 3.3.2, Cygwin. 

THEORY: 

 

Hadoop is a powerful framework for automatic parallelization of computing tasks. Unfortunately 

programming for it poses certain challenges. It is really hard to understand and debug Hadoop programs. One 

way to make it a little easier is to have a simplified version of the Hadoop cluster that runs locally on the 

developer's machine. This tutorial describes how to set up such a cluster on a computer running Microsoft 

Windows. It also describes how to integrate this cluster with Eclipse, a prime Java development environment. 

Prerequisites 

Before we begin, make sure the following components are installed on your workstation: 

 Java 1.6 

 Eclipse Europa 3.3.2 

This tutorial has been written for and tested with Hadoop version 0.19.1. If you are using another version, 

some things may not work. 

Make sure you have exactly the same versions of the software as shown above. Hadoop will not work with 

versions of Java earlier than 1.6 and versions of Eclipse later than 3.3.2 due to plug-in API incompatibility. 

Installing Cygwin 

After installing the prerequisite software, the next step is to install the Cygwin environment. Cygwin is a set 

of Unix packages ported to Microsoft Windows. It is needed to run the scripts supplied with Hadoop because 

they are all written for the Unix platform. 

To install the cygwin environment follow these steps: 

1. Download cygwin installer from http://www.cygwin.com. 

2. Run the downloaded file. You will see the window shown on the screenshots below.  

http://www.eclipse.org/downloads/packages/release/europa/winter


 

 

Cygwin Installer 

3. When you see the above screenshot, keep pressing the 'Next' button until you see the package selection 

screen shown below. Make sure you select 'openssh'. This package is required for the correct 

functioning of the Hadoop cluster and Eclipse plug-in. 

 

4. After you selected these packages press the 'Next' button to complete the installation. 



Set Environment Variables 

The next step is to set up the PATH environment variable so that Eclipse IDE can access Cygwin commands 

here 

To set environment variables follow these steps: 

1. Find "My Computer" icon either on the desktop or in the start menu, right-click on it and select 

Properties item from the menu. 

2. When you see the Properties dialog box, click on the Environment Variables button as shown below  

 

 

3. When Environment Variables dialog shows up, click on the Path variable located in the System 

Variables box and then click the Edit button. 



 

 
4. When Edit dialog appears append the following text to the end of the Variable value field: 

;c:\cygwin\bin;c:\cygwin\usr\bin  



 

Note: If you installed cygwin in the non-standard location, correct the above value accordingly.  

5. Close all three dialog boxes by pressing OK button of each dialog box. 

Setup SSH daemon 

Both Hadoop scripts and Eclipse plug-in need password-less SSH to operate. This section describes how to set 

it up in the Cygwin environment. 

Configure ssh daemon 

1. Open the Cygwin command prompt. 

2. Execute the following command: 

ssh-host-config 

3. When asked if privilege separation should be used, answer no. 

4. When asked if sshd should be installed as a service, answer yes. 

5. When asked about the value of CYGWIN environment variable, enter ntsec. 

6. Here is an example session of this command. Note that the input typed by the user is shown in pink 

and output from the system is shown in gray. 



 

 

Example of using ssh-host-config 

Start SSH daemon  

1. Find My Computer icon either on your desktop or in the start-up menu, right-click on it and select 

Manage from the context menu. 

2. Open Services and Applications in the left-hand panel then select the Services item. 

3. Find the CYGWIN sshd item in the main section and right-click on it. 

4. Select Start from the context menu.  

 

 

 

 

 



 

Start SSHD service 

  A small window should pop-up indicating the progress of the service start-up. After that window disappears 

the status of CYGWIN sshd service should change to Started.  

Setup authorization keys 

Eclipse plug-in and Hadoop scripts require ssh authentication to be performed through authorization keys 

rather than passwords. The following steps describe how authorization keys are set up. 

1. Open cygwin command prompt 

2. Execute the following command to generate keys 

ssh-keygen  

3. When prompted for filenames and pass phrases press ENTER to accept default values. 

4. After the command has finished generating keys, enter the following command to change into your 

.ssh directory:  

cd ~/.ssh  

5. Check if the keys were indeed generated by executing the following command:  

ls -l  



 

You should see two files id_rsa.pub and id_rsa with recent creation dates. These files contain 

authorization keys. 

6. To register the new authorization keys enter the following command (note the sharply-angled double 

brackets -- they are very important):  

cat id_rsa.pub >> authorized_keys 

 

Setting up authorization keys 

7. Now check if the keys were set up correctly by executing the following command:  

ssh localhost  

Since it is a new ssh installation, you will be warned that authenticity of the host could not be 

established and will be asked whether you really want to connect. Answer yes and press ENTER. You 

should see the Cygwin prompt again, which means that you have successfully connected. 

8. Now execute the command again:  

ssh localhost 

This time you should not be prompted for anything. 

 



Download, Copy and Unpack Hadoop 

The next step is to download and copy the Hadoop distribution. 

  

1. Download hadoop 0.19.1 and place in some folder on your computer such as C:\Java.  

2. Open Cygwin command prompt.  

3. Execute the following command:  

cd  

4. Execute the following command to enable your home directory folder to be shown in the Windows 

Explorer window:  

explorer .  

 

5. Open another Explorer window and navigate to the folder that contains the downloaded Hadoop 

archive. 

6. Copy the Hadoop archive into your home directory folder. 

Unpack Hadoop Installation 

The next step is to unpack the downloaded and copied package.  

http://apache.mirror99.com/hadoop/core/hadoop-0.19.1/


 

To unpack the package follow these steps: 

1. Open a new Cygwin window. 

2. After the new Cygwin window appears, execute the following command:  

tar -xzf hadoop-0.19.1.tar.gz 

This will start unpacking the Hadoop distribution. After several minutes you should see a new Cygwin 

prompt again as shown in the screenshot below: 

 

 

3. When you see the new prompt, execute the following command:  

ls -l 

This command will list the contents of your home directory. You should see a newly created directory 

called hadoop-0.19.1  

4. Next execute the following commands:  

cd hadoop-0.19.1 

ls -l 



 

If you get output similar to the following, everything was unpacked correctly and you can go to the 

next step.  

      total 4145 

 

      -rw-r--r--   1 vlad None  295315 Feb 19 19:13 CHANGES.txt 

 

      -rw-r--r--   1 vlad None   11358 Feb 19 19:13 LICENSE.txt 

 

      -rw-r--r--   1 vlad None     101 Feb 19 19:13 NOTICE.txt 

 

      -rw-r--r--   1 vlad None    1366 Feb 19 19:13 README.txt 

 

      drwxr-xr-x+  2 vlad None       0 Feb 26 05:41 bin 

 

      -rw-r--r--   1 vlad None   58440 Feb 19 19:13 build.xml 

 

      drwxr-xr-x+  4 vlad None       0 Feb 19 19:18 c++ 

 

      drwxr-xr-x+  2 vlad None       0 Mar 10 13:46 conf 

 

      drwxr-xr-x+ 12 vlad None       0 Feb 19 19:12 contrib 

 

      drwxr-xr-x+  7 vlad None       0 Feb 26 05:41 docs 

 

      -rw-r--r--   1 vlad None    6839 Feb 19 19:12 hadoop-0.19.1-ant.jar 

 

      -rw-r--r--   1 vlad None 2384306 Feb 19 19:18 hadoop-0.19.1-core.jar 

 

      -rw-r--r--   1 vlad None  134119 Feb 19 19:12 hadoop-0.19.1-examples.jar 

 

      -rw-r--r--   1 vlad None 1276792 Feb 19 19:18 hadoop-0.19.1-test.jar 

 

      -rw-r--r--   1 vlad None   52295 Feb 19 19:12 hadoop-0.19.1-tools.jar 

 

      drwxr-xr-x+  4 vlad None       0 Feb 26 05:41 lib 

 

      drwxr-xr-x+  3 vlad None       0 Feb 26 05:41 libhdfs 

 

      drwxr-xr-x+  2 vlad None       0 Feb 26 05:41 librecordio 

 

      drwxr-xr-x+  4 vlad None       0 Mar 10 13:46 logs 

 

      drwxr-xr-x+ 15 vlad None       0 Feb 26 05:41 src 

 

      -rwxr-xr-x   1 vlad None    1079 Mar  1 16:41 testProj.jar 

 

      drwxr-xr-x+  8 vlad None       0 Feb 19 19:12 webapps  

       

Configure Hadoop 

Now that Hadoop has been unpacked, we are ready to configure it. 



1. Open a new Cygwin window and execute the following commands: 

cd hadoop-0.19.1 

cd conf 

explorer . 

 

Bringing up explorer window 

1. The last command will cause the Explorer window for the 'conf' directory to pop up. Minimize it for 

now or move it to the side. 

2. Launch Eclipse. 

3. Bring up the 'conf' Explorer window opened in Step 2 and drag the file hadoop-site to the Eclipse 

main window. 

4. Insert the following lines between <configuration> and </configuration> tags.  
5. <property> 

 

6. <name>fs.default.name</name> 

 

7. <value>hdfs://localhost:9100</value> 

 

8. </property> 

 

9. <property> 

 

10. <name>mapred.job.tracker</name> 

 

11. <value>localhost:9101</value> 

 

12. </property> 

 

13. <property> 

 



14. <name>dfs.replication</name> 

 

15. <value>1</value> 

 

16. </property>  

         

 

Editing site configuration file 

 

17. Close the Eclipse, Cygwin command and Explorer windows. 

Format the namenode 

Next step is to format the Namenode to create a Hadoop Distributed File System (HDFS). 

1. Open a new Cygwin window. 

2. Execute the following commands:  

cd hadoop-0.19.1 

mkdir logs 

bin/hadoop namenode -format 

 



 

Format the namenode 

3. The last command will run for some time and produce output similar to that shown below:  

 

Hadoop Distributed File System created. 



Now that the filesystem has been created you can proceed to the next step. 

Install Hadoop plug-in 

The next step is to install and check the Hadoop plug-in for Eclipse. 

1. Open a new Cygwin window and execute the following commands:  

cd hadoop-0.19.1 

cd contrib 

cd eclipse-plugin 

explorer . 

 

Navigate to Hadoop eclipse plugin folder 

 

2. Shrink the newly popped window and move it to the right of the screen. 

3. Open another Explorer window either through "My Computer" icon or by using the "Start -> Run" 

menu. Navigate to the Eclipse installation and open the "plugins" folder. 



4. Copy the file "hadoop-0.19.1-eclipse-plugin.jar" from the Hadoop eclipse-plugin folder to the Eclipse 

plugins folder as shown in the figure below.  

 

Copy Hadoop Eclipse Plugin 

5. Close both explorer windows 

6. Start Eclipse 

7. Click on the open perspective icon, which is usually located in the upper-right corner the eclipse 

application. Then select Other from the menu. 

8. Select Map/Reduce from the list of perspectives and press "OK" button. 

9. As a result your IDE should open a new perspective that looks similar to the image below. 

 

 

 

 

 



 

Eclipse Map/Reduce Perspective 

Now that the we installed and configured hadoop cluster and eclipse plugin i's a time to test the setup by 

running a simple project. 

Start the local hadoop cluster 

Next step is to launch the newly configured cluster. 

1. Close all the windows on the desktop, open five Cygwin windows and arrange them as shown below.  



 

2. Start the namenode in the first window by executing:  

cd hadoop-0.19.1 

bin/hadoop namenode 

3. Start the secondary namenode in the second window by executing:  

cd hadoop-0.19.1 

bin/hadoop secondarynamenode 

4. Start the job tracker the third window by executing:  

cd hadoop-0.19.1 

bin/haoop jobtracker 

5. Start the data node the fourth window by executing:  

cd hadoop-0.19.1 

bin/haoop datanode 

6. Start the task tracker the fifth window by executing:  

cd hadoop-0.19.1 

bin/haoop tasktracker 



7. Now you should have an operational hadoop cluster. If everthing went fine your screen should look 

like the image below: 

 

 

At this point the cluster is running and you can proceed to the next step.  

Setup Hadoop Location in Eclipse 

Next step is to configure Hadoop location in the Eclipse environment. 

1. Launch the Eclipse environment. 

2. Open Map/Reduce perspective by clicking on the open perspective icon ( ), select "Other" from the 

menu, and then select "Map/Reduce" from the list of perspectives.  



 

3. After switching to the Map/Reduce perspective, select the Map/Reduce Locations tab located at the 

bottom of the Eclipse environment. Then right click on the blank space in that tab and select "New 

Hadoop location...." from the context menu. You should see a dialog box similar to the one shown 

below. 



 

Setting up new Map/Reduce location 

4. Fill in the following items, as shown on the figure above. 

o Location Name -- localhost 

o Map/Reduce Master  

 Host -- localhost 

 Port -- 9101 

o DFS Master  

 Check "Use M/R Master Host" 

 Port -- 9100 

o User name -- User 

Then press the Finish button. 

5. After closing the Hadoop location settings dialog you should see a new location in the "Map/Reduce 

Locations" tab. 

6. In the Project Explorer tab on the left hand side of the Eclipse window, find the DFS Locations item. 

Open it using the "+" icon on its left. Inside, you should see the localhost location reference with the 

blue elephant icon. Keep opening the items below it until you see something like the image below.  



 

7. Browsing HDFS location 

You can now move on to the next step. 

Upload data to HDFS 

We are now ready to run the first Map/Reduce project but data is still missing. This section explains how to 

upload data to the Hadoop Distributed File System (HDFS). 

Upload Files To HDFS 

1. Open a new CYGWIN command window.  



 

2. Execute the following commands in the new CYGWIN window as shown on the image above.  

cd hadoop-0.19.1 

bin/hadoop fs -mkdir In 

bin/hadoop fs -put *.txt In 

When the last of the above commands starts executing, you should see some activity in other Hadoop 

windows as shown in the image below. 



 

The result of these commands is a newly created directory -- named In -- in the HDFS which contains 

a set of text files that comes with the Hadoop distribution. 

3. Close the Cygwin Window. 

Verify if the files were uploaded correctly 

In this section we will check if the files were uploaded correctly. 

1. Open the Eclipse environment. 

2. Open DFS locations folder which is located in the Project Explorer tab of Map/Reduce perspective. 

3. Open localhost folder in DFS locations folder. 

4. Keep opening HDFS folders until you navigate to the newly created In directory, as shown in the 

image below.  

  

  



 

Verifying that the data was uploaded correctly 

5. When you get to the In directory, double-click on the file LICENCE.txt to open it. 

6. If you see something similar to the image above then the data was uploaded correctly and you can 

proceed to your first Hadoop project.  

Now move on to the next step. 

Create and run Hadoop project 

Now we are ready to create and run out first Hadoop project.  

Creating and configuring Hadoop eclipse project. 

1. Launch Eclipse. 

2. Right-click on the blank space in the Project Explorer window and select New -> Project.. to create 

a new project. 



3. Select Map/Reduce Project from the list of project types as shown in the image below. 

 

 

 

4. Press the Next button. 



5. You will see the project properties window similar to the one shown below 

 

 
6. Fill in the project name and click on Configure Hadoop Installation link on the right hand side of the 

project configuration window. This will bring up the project Preferences window shown in the image 

below. 

 

 

7. In the project Preferences window enter the location of the Hadoop directory in the Hadoop 

installation directory field as shown above.  

If you are not sure of the location of the Hadoop home directory, refer to Step 1 of this section. 

Hadoop home directory is one level up from the conf directory. 



 

8. After entering the location close the Preferences window by pressing the OK button. Then close the 

Project window with the Finish button. 

9. You have now created your first Hadoop Eclipse project. You should see its name in the Project 

Explorer tab. 

Creating Map/Reduce driver class 

1. Right-click on the newly created Hadoop project in the Project Explorer tab and select New -> Other 

from the context menu. 

2. Go to the Map/Reduce folder, select MapReduceDriver, then press the Next button as shown in the 

image below. 

 

 
3. When the MapReduce Driver wizard appears, enter TestDriver in the Name field and press the 

Finish button. This will create the skeleton code for the MapReduce Driver.  



 

 
4. Unfortunately the Hadoop plug-in for Eclipse is slightly out of step with the recent Hadoop API, so we 

need to edit the driver code a bit. 

 

Find the following two lines in the source code and comment them out:  

conf.setInputPath(new Path("src")); 

conf.setOutputPath(new Path("out")); 

Enter the following code immediatly after the two lines you just commented out (see image below): 

conf.setInputFormat(TextInputFormat.class); 

conf.setOutputFormat(TextOutputFormat.class); 

 

FileInputFormat.setInputPaths(conf, new Path("In")); 

FileOutputFormat.setOutputPath(conf, new Path("Out")); 



 

 

 

5. After you have changed the code, you will see the new lines marked as incorrect by Eclipse. Click on 

the error icon for each line and select Eclipse's suggestion to import the missing class. 

 

You need to import the following classes: TextInputFormat, TextOutputFormat, FileInputFormat, 

FileOutputFormat. 

6. After the missing classes are imported you are ready to run the project. 

Running Hadoop Project 

1. Right-click on the TestDriver class in the Project Explorer tab and select Run As --> Run on 

Hadoop. This will bring up a window like the one shown below. 



 

 

 

2. In the window shown above select "Choose existing Hadoop location" , then select localhost from the 

list below. After that click Finish button to start your project. 

3. If you see console output similar to the one shown below, Congratulations! You have started the 

project successfully! 

 

 

 



Experiment No. 6 
 

Objective: Working  and installation of  Google App Engine. 

 

Requirement: Login account codenvy. 

 

THEORY: 

Deploying a New Application GAE 

With Codenvy you can deploy Java, Python and PHP apps to Google App Engine. 

 create a new project from scratch and choose either Java web application or Python and Google App 

Engine as PaaS (if you have already created a project, then open it and go to PaaS > Google App 

Engine > Create Application) 

 enter project name and choose a Template 

 check Use existing GAE ID if you want to overwrite an existing app 

 click Create button 

 if you deploy your first app to GAE from Codenvy you need to authenticate 

 allow access to proceed 

 enter required information at the GAE webpage (Application Title is optional) 

 

Click to see a full sized image 

 once you click Create Application, the browser’s tab will be automatically closed in a few seconds 

 when you are back to your Codenvy workspace, click Deploy to push the app to GAE 

The process may take several minutes, and you will see a confirmation message in the Output panel with the 

application url - yourappname.appspot.com 

http://docs.codenvy.com/wp-content/uploads/gae_create.png


 Make sure you use the same Google ID to log in to Codenvy and Google App Engine. Using different 

accounts may cause 401 or 404 errors. 401 error can be fixed by logging out, and then logging in Google App 

Engine at PaaS > Google App Engine > Logout/Login 

Watch the entire process of deploying an app to GAE in the below video 

Updating an Existing Application GAE 

Having deployed your application to GAE, you can make some changes to the code and easily update it. 

 The application is updated at Project > PaaS > Google App Engine 

 The project is re-built and re-deployed once you press Application Update button. An alternative way 

to update your GAE app is to go to PaaS > Google App Engine > Update Application. 

 

Three messages (project build, start and end of deployment) appear in the Output panel one by on. Once done, 

changes are implemented in the application hosted on appspot.com. 

Have a look at this short video demonstrating how you can update your GAE apps directly from Codenvy: 

Managing GAE Applications 

You can manage your GAE application at Project  >PaaS > Google App Engine. 

It’s possible to modify and vacuum Indexes, PageSpeed, Queues, DoS as well as have a look at recourse 

limits, cron jobs and backends. 

http://docs.codenvy.com/wp-content/uploads/gae_manage.png
http://docs.codenvy.com/wp-content/uploads/gae_manage.png


 

Import an Existing GAE Application 

If you have a GAE application which you need to import to Codenvy, here’s a workaround (this is not a direct 

import of source code, so it will take a few minutes or so): 

 download source code of your app (of course, this step can be omitted if you have in on GitHub and 

sync it regularly). You can download source code of your Java and Python apps using SDK command 

line (check out GAE documentation). 

 push this code to GitHub or whatever remote repository you use 

 clone your GitHub project to Codenvy 

 open appengine-web.xml file and edit application ID, if necessary, for 

example <application>javagae112</application> (enter the app ID you need to update on GAE) 

 if you want to create a new version of the same app, you can change it as well, for 

example <version>2</version> 

<appengine-web-app xmlns="http://appengine.google.com/ns/1.0"> 

  <application>java112</application> 

  <version>1</version> 

 update application at Project > PaaS > Google App Engine.  

Once the app is updated, you can change and update it anytime directly from Codenvy. 

 Since Codenvy uses Maven as a build manager, the projects you clone should also be built with Maven, i.e. 

contain pom.xml file in the root project folder. 

http://docs.codenvy.com/wp-content/uploads/gae_manage1.png
http://docs.codenvy.com/wp-content/uploads/gae_manage1.png


You may have a look at this short video demonstrating the procedure of importing an existing GAE app to 

Codenvy using GitHub. 

Device Support 

Codenvy currently supports all desktop and laptop devices. We currently provide touch device support 

through the use of the Puffin Web Browser which virtualizes double clicks and right clicks.  We have not yet 

created a native touch UI design. Vote for this feature at our Uservoice page. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://codenvy.uservoice.com/forums/183121-general/suggestions/3373075-tablet-touch-ui-support
http://codenvy.uservoice.com/forums/183121-general/suggestions/3373075-tablet-touch-ui-support


Experiment No. 7 
 

Objective: Working  and installation of  Microsoft Azure. 

 

Requirement: Account on  Microsoft Azure 

THEORY: 

Introduction: 

In this article we are going to see how to create a new database stored procedure using the new Azure portal 

instead of using the SQL Server Management Studio. 

Overview: 

Stored procedures are created normally using the SQL Serve management studio, with the latest version of 

SQL Azure we have option to create a user stored procedure directly online without need to have a local 

interface. This way we have some control of using it anywhere anytime to do some updates regularly.   

Let us see how to create the Stored procedure in Azure portal step by step. 

Steps: 

Log in to the Azure portal using the below link. You can see the screen look similar to below 

http://www.microsoft.com/windowsazure/ 

 

Login to the portal using your Microsoft Windows Live credentials with Azure credentials to the management 

portal and you will see the screen as shown in the screen below 

http://f5debug.net/image.axd?picture=clip_image002_4.png
http://f5debug.net/image.axd?picture=clip_image002_4.png


 

Now we can see the Database Menu at the bottom left, Click on that will go to the Database Subscription 

window as shown in the screen below 

 

Clicking on the subscription name will provide the complete details of the server created and the new database 

created as shown in the screen below 

http://f5debug.net/image.axd?picture=clip_image004_51.jpg
http://f5debug.net/image.axd?picture=clip_image004_51.jpg
http://f5debug.net/image.axd?picture=clip_image006_11.png
http://f5debug.net/image.axd?picture=clip_image006_11.png


 

Now we have a database created(LearnAzure) with a Max size of 1GB and ready to use it for the application 

based on the requirement. To create a new Stored Procedure click on Manage at the top menu tool bar as 

shown in the screen below 

 

Check my previous article on how to connect to the manage portal using the credentials and the firewall using 

the link. Once logged in you screen will look like below 

http://f5debug.net/image.axd?picture=clip_image008_8.png
http://f5debug.net/image.axd?picture=clip_image010_6.png


 

To create a new stored procedure click on New Stored procedure menu at the top and we will see a script 

window as shown in the screen below 

 

http://f5debug.net/image.axd?picture=clip_image012_6.png
http://f5debug.net/image.axd?picture=clip_image013_5.png


Now we will write our customized stored procedure for the EmpDetails table which we created in our earlier 

tutorial(Check my previous article for table creation) as shown in the screen below 

Once we create the structure for the stored procedure as shown in the above screen we need to save it. Once 

save we can use the stored procedure to execute the same as shown in the screen below. We need to navigate 

to the new query window in the Database section and write a execute command as shown below. 

 

We can create n Number of stored procedure as per the requirement and use it across the process which we 

normally do with the traditional SQL Server locally. 

http://f5debug.net/image.axd?picture=clip_image014_4.png
http://f5debug.net/image.axd?picture=clip_image014_4.png
http://f5debug.net/image.axd?picture=clip_image015_3.png


Experiment No. 8 
 

Objective: Working with Mangrasoft Aneka Software. 

 

Requirement: ECMA Runtime  Environment, Database 

THEORY: 
 
Aneka  is a Cloud Application  Development  Platform  (CAP)  for developing and  running compute  and  

data  intensive  applications.  As  a  platform  it  provides users  with both  a runtime  environment  for 

executing  applications  developed  using  any  of  the  three supported  programming  models,  and  a  set  of  

APIs  and  tools  that  allow  you  to  build  new applications  or  run  existing  legacy  code. The  purpose  of  

this  document  is  to  help  you through  the  process  of  installing  and  setting  up  an  Aneka  Cloud  

environment.  This document  will  cover  everything  from  helping  you  to  understand  your  existing 

infrastructure,  different  deployment  options,  installing  the  Management  Studio, configuring  Aneka  

Daemons  and  Containers,  and  finally  running  some  of  the  samples  to test your environment. 

 

An  Aneka  Cloud  is  composed  of  a  collection  of  services  deployed  on  top of  an infrastructure. This 

infrastructure can include both physical and virtual machines located in your local area network or Data 

Centre. Aneka services are hosted on Aneka Containers which  are  managed  by Aneka  Daemons. An  

Aneka  Daemon  is a background  service that runs on a machine and helps you to install, start, stop, update 

and reconfigure Containers.  

 

A  key  component  of  the  Aneka  platform  is  the  Aneka  Management  Studio,  a  portal  for managing 

your infrastructure and clouds. Administrators use the Aneka Management Studio to  define  their  

infrastructure,  deploy  Aneka  Daemons,  and  install  and  configure  Aneka Containers.  The  figure  below  

shows  a  high-level  representation  of  an  Aneka  Cloud, composed of a Master Container that is responsible 

for scheduling jobs to Workers, and a group  of  Worker  Containers  that  execute  the  jobs.  Each  machine  

is  typically  configured with a single instance of the Aneka Daemon and a single instance of the Aneka 

Container. 

 

Installation  
This section assumes that you have a copy of the Aneka distribution with you. If you do not  have a copy 

already, you can download the latest version from Manjrasoft’s Website.  

 

Installing Aneka Cloud Management Studio  
Aneka  installation begins  with  installing  Aneka  Cloud  Management  Studio. The  Cloud Management  

Studio  is  your  portal  for  creating,  configuring  and  managing Aneka Clouds. Installing  Aneka  using  the  

distributed  Microsoft  Installer  Package  (MSI)  is  a  quick  process involving three steps as described 

below. 

 

Step 1 – Run the installer package to start the Setup Wizard 



 
Figure  - Welcome Page 

The Welcome Page is self-explanatory and you can proceed by clicking next. 

Step 2 – Specifying the installation folder 

In Step  2 you  specify  the installation  folder.  By  default  Aneka  is  installed  in  C:\Program  

Files\Manjrasoft\Aneka.3.0.   

 
Figure  - Specifying the installation folder 



Step 3 – Confirm and start the installation 

At this point you are ready to begin the installation. Click ―Next‖ to start the installation or ―Back‖ to change 

your installation folder. 

 
Figure  - Confirm Installation 

Once the installation is complete, close the wizard and launch Aneka Management Studio from the start 

menu. 

 

 

 

 

 
Figure  - Installation Progress 

 

 



 
 

Figure  - Installation Complete 

 

 

 
 

Figure  - Start Menu 

 

Aneka Cloud Management Studio  

The Aneka Cloud Management Studio  is your portal for  managing your infrastructure and clouds. It provides 

facilities for defining your underlying cloud infrastructure and creating one  or  more Aneka  Clouds  on  top. 

It  lets  you  create  and manage  Aneka user  accounts, monitor  the overall performance  of your Cloud, 



obtain detailed reporting information on resource  usage, data  transfers, billing  and application  (job) 

execution. It  also  provides facilities  for  troubleshooting  your deployments  by allowing  you  to  access and  

examine remote logs. 

 

Starting up Management Studio 

 

 
Figure  - Starting Aneka Cloud Management Studio for the first time. 

 

When Aneka Cloud Management Studio is started up for the first time you’ll be asked to create  a Remote 

Repository for performing remote  installations.  Setting  up  a Remote Repository requires selecting  a  

suitable  repository  type  and supplying valid credentials which remote machines can use to connect and 

download required files. You may however choose  to  create  this repository at  a  late  time  before  making  

remote  installations.  If  no repository is defined, you will be restricted to making local installations only. 

 

 



 
Figure  - Creating a repository for remote installations 

 

Shutting down Aneka Management Studio  

When attempting to shut down Aneka Management Studio, you will be given the choice of saving all 

configuration data from the current session. It is highly recommended that you save this information and 

restore it the next time you start using the Management Studio.   

The Configuration File   

The  configuration  file, ManagementStudio.config, contains all  information that  describes your 

infrastructure, your Clouds, the machine credentials, repositories and authentication keys  (see  section  on 

installing  the  Master Container)  that  you  defined  when  using  Aneka Management  Studio.  It  is 

recommended that  you  save  this  information  when  you  exit Management Studio so that you can restore it 

at a later session, and get up-to-speed with your Cloud management without having to redefine all settings 

again. Some configuration information, such as authentication keys, must be maintained safely if you are to 

add new Containers  to  your  existing Cloud.  Losing  an  authentication  key  however, is  not detrimental as 

you will be able to reconfigure your clouds with a new key.   

 

 

 
 

Figure  - Request to save configuration data when closing Management Studio 

 



The  configuration  file  is  always  encrypted  before  being  written to  disk  for  security reasons. When  

saving  configuration  data  you  will  be  required  to  specify  a password  as show in Figure. 

 

 

 
 

Figure  - Password to encrypt configuration data 

 

 

 

When starting up Aneka Management Studio at a later session, you will be given the choice of restoring your 

configuration data. If you choose to do so, you must re-enter the same password you used when saving. 

 

 
 

Figure  - Request to restore configuration data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Viva Questions 

Ques1: How does cloud computing provides on-demand functionality? 

Ans: Cloud computing is a metaphor used for internet. It provides on-demand access to virtualized IT 

resources that can be shared by others or subscribed by you. It provides an easy way to provide configurable 

resources by taking it from a shared pool. The pool consists of networks, servers, storage, applications and 

services. 

 

Ques2: What is the difference between scalability and elasticity? 

Ans: Scalability is a characteristic of cloud computing through which increasing workload can be handled by 

increasing in proportion the amount of resource capacity. It allows the architecture to provide on demand 

resources if the requirement is being raised by the traffic. Whereas, elasticity is being one of the characteristic 

provide the concept of commissioning and decommissioning of large amount of resource capacity 

dynamically. It is measured by the speed by which the resources are coming on demand and the usage of the 

resources. 

 

Ques3: What are the different layers of cloud computing? 

Ans: Cloud computing consists of 3 layers in the hierarchy and these are as follows:  

1. Infrastructure as a Service (IaaS) provides cloud infrastructure in terms of hardware like memory, 

processor speed etc.  

2. Platform as a Service (PaaS) provides cloud application platform for the developers.  

3. Software as a Service (SaaS) provides cloud applications which are used by the user directly without 

installing anything on the system. The application remains on the cloud and it can be saved and edited in there 

only. 

 

Ques4: What resources are provided by infrastructure as a service? 

Ans: Infrastructure as a Service provides physical and virtual resources that are used to build a cloud. 

Infrastructure deals with the complexities of maintaining and deploying of the services provided by this layer. 

The infrastructure here is the servers, storage and other hardware systems. 

 

Ques5: How important is platform as a service? 

Ans: Platform as a Service is an important layer in cloud architecture. It is built on the infrastructure model, 

which provides resources like computers, storage and network. This layer includes organizing and operate the 

resources provided by the below layer. It is also responsible to provide complete virtualization of the 

infrastructure layer to make it look like a single server and keep it hidden from the outside world. 

 

Ques6: What does software as a service provide? 

Ans: Software as Service is another layer of cloud computing, which provides cloud applications like Google 

is doing, it is providing Google docs for the user to save their documents on the cloud and create as well. It 

provides the applications to be created on fly without adding or installing any extra software component. It 

provides built in software to create wide varieties of applications and documents and share it with other 

people online. 

 

Ques7: What are the different deployment models? 

Ans: Cloud computing supports many deployment models and they are as follows:  

- Private Cloud  



Organizations choose to build their private cloud as to keep the strategic, operation and other reasons to 

themselves and they feel more secure to do it. It is a complete platform which is fully functional and can be 

owned, operated and restricted to only an organization or an industry. More organizations have moved to 

private clouds due to security concerns. Virtual private cloud is being used that operate by a hosting company.  

- Public Cloud  
these are the platforms which are public means open to the people for use and deployment. For example, 

Google, Amazon etc. They focus on a few layers like cloud application, infrastructure providing and 

providing platform markets.  

- Hybrid Clouds  
It is the combination of public and private cloud. It is the most robust approach to implement cloud 

architecture as it includes the functionalities and features of both the worlds. It allows organizations to create 

their own cloud and allow them to give the control over to someone else as well. 

 

Ques8: What are the different datacenters deployed for this? 

Ans: Cloud computing is made up of various datacenters put together in a grid form. It consists of different 

datacenters like:  

- Containerized Datacenters  
These are the traditional datacenters that allow high level of customization with servers, mainframe and other 

resources. It requires planning, cooling, networking and power to access and work.  

- Low-Density Datacenters  
These datacenters are optimized to give high performance. In these datacenters the space constraint is being 

removed and there is an increased density. It has a drawback that with high density the heat issue also creeps 

in. These datacenters are very much suitable to develop the cloud infrastructure. 

 

Ques9: What are the different modes of software as a service? 

Ans: Software as a Service provides cloud application platform on which user can create application with the 

tools provided. The modes of software as a service is defined as:  

1. Simple multi-tenancy: in this each user has its own resources that are different from other users. It is an 

inefficient mode where the user has to put more time and money to add more infrastructure if the demand 

rises in less time to deliver.  

2. Fine grain multi-tenancy: in this the functionality remains the same that the resources can be shared too 

many. But it is more efficient as the resources are shared not the data and permission within an application. 

 

Ques10: What is the security aspects provided with cloud? 

Ans: Security is one of the major aspects which come with any application and service used by the user. 

Companies or organizations remain much more concerned with the security provided with the cloud. There 

are many levels of security which has to be provided within cloud environment such as:  

- Identity management: it authorizes the application service or hardware component to be used by authorized 

users.  

- Access control: permissions has to be provided to the users so that they can control the access of other users 

who are entering the in the cloud environment.  

- Authorization and authentication: provision should be made to allow the authorized and authenticated 

people only to access and change the applications and data. 

 

Ques11: What is the difference between traditional datacenters and cloud? 

Ans: Cloud computing uses the concept of datacenter as it is the datacenter is based on the tradition one so the 

difference between them are as follows:  



- Cost of the traditional datacenter is higher, due to heating issues and other hardware/software related issues 

but this is not the case with the cloud computing infrastructure.  

- It gets scaled when the demand increases. Most of the cost is being spent on the maintenance being 

performed on the datacenters, whereas cloud platform requires minimum maintenance and not very expert 

hand to handle them. 

 

Ques12: What are the three cost factors involves in cloud data center? 

Ans: Cloud data center doesn't require experts to operate it, but it requires skilled people to see the 

maintenance, maintain the workloads and to keep the track of the traffic. The labor cost is 6% of the total cost 

to operate the cloud data center. Power distribution and cooling of the datacenter cost 20% of the total cost. 

Computing cost is at the end and is the highest as it is where lots of resources and installation has to be done. 

It costs the maximum left percentage. 

 

Ques13: How the cloud services are measured? 

Ans: Cloud computing provides the services to the organizations so they can run their applications and install 

them on the cloud. Virtualization is used to deploy the cloud computing models as it provides a hidden layer 

between the user and the physical layer of the system. The cloud services are measured in terms of use. Pay as 

much as you use that can be on the basis of hours or months or years. Cloud services allow users to pay for 

only what they use and according to the demand the charges or the prices gets increased. 

 

Ques14: What are the optimizing strategies used in cloud? 

Ans: To optimize the cost and other resources there is a concept of three-data-center which provides backups 

in cases of disaster recovery and allows you to keep all the data intact in the case of any failure within the 

system. System management can be done more efficiently by carrying out pre-emptive tasks on the services 

and the processes which are running for the job. Security can be more advanced to allow only the limited 

users to access the services 

 

Ques15: What are different data types used in cloud computing? 

Ans: Cloud computing is going all together for a different look as it now includes different data types like 

emails, contracts, images, blogs, etc. The amount of data increasing day by day and cloud computing is 

requiring new and efficient data types to store them. For example if you want to save video then you need a 

data type to save that. Latency requirements are increasing as the demand is increasing. Companies are going 

for lower latency for many applications. 

 

Ques16: What are the security laws which take care of the data in the cloud? 

Ans: The security laws which are implements to secure data in the cloud are as follows: Input validation: 

controls the input data which is being to any system. Processing: control that the data is being processed 

correctly and completely in an application. File: control the data being manipulated in any type of file. Output 

reconciliation: control the data that has to be reconciled from input to output. Backup and recovery: control 

the security breaches logs and the problems which has occurred while creating the back. 

 

Ques17: How to secure your data for transport in cloud? 

Ans: Cloud computing provides very good and easy to use feature to an organization, but at the same time it 

brings lots of question that how secure is the data, which has to be transported from one place to another in 

cloud. So, to make sure it remains secure when it moves from point A to point B in cloud, check that there is 

no data leak with the encryption key implemented with the data you sending. 

 



Ques18: What do you understand from VPN? 

Ans: VPN stands for virtual private network; it is a private cloud which manages the security of the data 

during the transport in the cloud environment. VPN allows an organization to make a public network as 

private network and use it to transfer files and other resources on a network. 

 

Ques19: What does a VPN consists of? 

Ans: VPN is known as virtual private network and it consists of two important things:  

1. Firewall: it acts as a barrier between the public network and any private network. It filters the messages 

that are getting exchanged between the networks. It also protects from any malicious activity being done on 

the network.  

2. Encryption: it is used to protect the sensitive data from professional hackers and other spammers who are 

usually remain active to get the data. With a message always there will be a key with which you can match the 

key provided to you. 

 

Ques20: Name few platforms which are used for large scale cloud computing. 

Ans: There are many platforms available for cloud computing but to model the large scale distributed 

computing the platforms are as follows:  

1. Map Reduce: is software that is being built by Google to support distributed computing. It is a framework 

that works on large set of data. It utilizes the cloud resources and distributes the data to several other 

computers known as clusters. It has the capability to deal with both structured and non-structured data.  

2. Apache Hadoop: is an open source distributed computing platform. It is being written in Java. It creates a 

pool of computer each with hadoop file system. It then clusters the data elements and applies the hash 

algorithms that are similar. Then it creates copy of the files that already exist. 

 

Ques21: What are some examples of large cloud providers and their databases? 

Ans: Cloud computing has many providers and it is supported on the large scale. The providers with their 

databases are as follows:  

- Google big table: it is a hybrid cloud that consists of a big table that is spilt into tables and rows. Map 

Reduce is used for modifying and generating the data.  

- Amazon SimpleDB: is a web service that is used for indexing and querying the data. It allows the storing, 

processing and creating query on the data set within the cloud platform. It has a system that automatically 

indexes the data.  

- Cloud based SQL: is introduced by Microsoft and it is based on SQL database. it provides data storage by 

the usage of relational model in the cloud. The data can be accessed from the cloud using the client 

application. 

 

 

Ques22: What are some open source cloud computing platform databases? 

Ans: Cloud computing platform has various databases that are in support. The open source databases that are 

developed to support it is as follows:  

1. MongoDB: is an open source database system which is schema free and document oriented database. It is 

written in C++ and provides tables and high storage space.  

2. CouchDB: is an open source database system based on Apache server and used to store the data efficiently  

3. LucidDB: is the database made in Java/C++ for data warehousing. It provides features and functionalities 

to maintain data warehouse. 

 

 



Ques23: What are some open source cloud computing platforms for PaaS? 

Ans: 

 Cloud Bees 

 Cod envy 

 Cloud9 

 I9 

Ques24: What essential things a user should know before going for cloud computing platform? 

Ans: A user should know some parameters by which he can go for the cloud computing services. The 

parameters are as follows:  

1. User should know the data integrity in cloud computing: It is a measure to ensure integrity like the data 

is accurate, complete and reasonable.  

2. Compliance: user should make sure that proper rules and regulations are followed while implementing the 

structure.  

3. Loss of data: user should know about the provisions that are provided in case of loss of data so that backup 

and recovery can be possible.  

4. Business continuity plans: user should think about does the cloud services provide him uninterrupted data 

resources.  

5. Uptime: user should know about the uptime the cloud computing platform provides and how helpful it is 

for the business.  

6. Data storage costs: user should find out about the cost which you have to pay before you go for cloud 

computing. 

 

Ques25: What are system integrators? 

Ans: Systems integrators are the important part of cloud computing platform. It provides the strategy of the 

complicated process used to design a cloud platform. It includes well defined architecture to find the resources 

and the characteristics which have to be included for cloud computing. Integrators plan the users cloud 

strategy implementation. Integrators have knowledge about data center creation and also allow more accurate 

private and hybrid cloud creation. 

 

Ques26: What is the requirement of virtualization platforms in implementing cloud? 

Ans: Virtualization is the basis of the cloud computing and there are many platforms that are available like 

VMware is a technology that provides the provision to create private cloud and provide a bridge to connect 

external cloud with private cloud. There are three key features that have to be identified to make a private 

cloud that is:  

- Cloud operating system.  

- Manage the Service level policies  

- Virtualization keeps the user level and the backend level concepts different from each other so that a 

seamless environment can be created between both. 

 

Ques27: What is the use of eucalyptus in cloud computing environment? 

Ans: Eucalyptus stands for Elastic Utility Computing Architecture for Linking Your Programs to Useful 

Systems and provides an open source software infrastructure to implement clusters in cloud computing 

platform. It is used to build private, public and hybrid clouds. It can also produce your own datacenter into a 



private cloud and allow you to extend the functionality to many other organizations. Eucalyptus provides 

APIs to be used with the web services to cope up with the demand of resources used in the private clouds. 

 

Ques28: Explain different layers which define cloud architecture? 

Ans: Cloud computing architecture consists of many layers which help it to be more organized and can be 

managed from one place. The layers are as follows:  

1. Cloud controller or CLC is the top most level in the hierarchy which is used to manage the virtualized 

resources like servers, network and storage with the user APIs.  

2. Walrus is used for the storage and act as a storage controller to manage the demands of the users. It 

maintains a scalable approach to control the virtual machine images and user data.  

3. Cluster Controller or CC is used to control all the virtual machines for executions the virtual machines are 

stored on the nodes and manages the virtual networking between Virtual machines and external users.  

4. Storage Controller or SC provides a storage area in block form that are dynamically attached by Virtual 

machines.  

5. Node Controller or NC is at the lowest level and provides the functionality of a hypervisor that controls the 

VMs activities, which includes execution, management and termination of many instances. 

 

Ques29: How user will gain from utility computing? 

Ans: Utility computing allow the user to pay per use means whatever they are using only for that they have to 

pay. It is a plug in that needs to be managed by the organizations on deciding what type of services has to be 

deployed from the cloud. Utility computing allows the user to think and implement the services according to 

them. Most organizations go for hybrid strategy that combines internal delivered services that are hosted or 

outsourced services. 

 

Ques30: Is there any difference in cloud computing and computing for mobiles? 

Ans: Mobile cloud computing uses the same concept but it just adds a device of mobile. Cloud computing 

comes in action when a task or a data get kept on the internet rather then individual devices. It provides users 

on demand access to the data which they have to retrieve. Applications run on the remote server, and then 

given to the user to be able to, store and manage it from the mobile platform. 

 

Ques31: What do you understand by Map Reduce? 

Ans: Map Reduce is a software framework that was created by Google. It`s prime focus was to aid in 

distributed computing, specifically large sets of data on a group of many computers. The frameworks took its 

inspiration from the map and reduce functions from functional programming. 

 

Ques32: Explain how map reduce works? 

Ans: The processing can occur on data which are in a file system (unstructured) or in a database (structured). 

The map reduce framework primarily works on two steps:  

1. Map step: During this step the master node accepts an input (problem) and splits it into smaller problems. 

Now the node distributes the small sub problems to the worker node so that they can solve the problem.  

2. Reduce step: Once the sub problem is solved by the worker node, the node returns a solution to the master 

node which accepts all the solutions of the worker node and re-compiles them into a solution. This solution is 

for the input that was provided to the master node. 

 

 

 

 



Ques33: What is an input reader in reference to map reduce? 

Ans: The input reader as the name suggests primarily has two functions:  

1. Reading the Input  

2. Splitting it into sub-parts  
The input reader accepts a user entered problem and then it divides/splits the problem into parts which then 

each are assigned a map function. Also an input reader will always read data from a stable storage source only 

to avoid problems. 

 

Ques34: How is map reduce related to cloud computing? 

Ans: The map reduce framework contains most of the key architecture principles of cloud computing such as:  

- Scale: The framework is able to expand itself in direct proportion to the number of machines available.  

- Reliable: The framework is able to compensate for a lost node and restart the task on a different node.  

- Affordable: A user can start small and over time can add more hardware.  

Due to the above features the map reduce framework has become the platform of choice for the development 

of cloud applications. 

 

Ques35: How does fault tolerance work in map reduce? 

Ans: In a map reduce job the master pings each worker periodically. In case a worker does not respond to that 

system then the system is marked as failed. Even completed tasks are rescheduled because the output was 

stored in a in a local disk of a worker which failed. Hence map reduce is able to handle large-scale failures 

easily by simply restarting a task. The master node always saves itself at checkpoints and in case of any 

failure it simply restarts from that checkpoint. 

 

Ques36: What is Hypervisor in Cloud Computing and its types? 

Ans: The hypervisor is a virtual machine monitor (VMM) that manages resources for virtual machines. The 

name hypervisor is suggested as it is a supervisory tool for the virtual machines. There are mainly two types 

of hypervisors :  

-> Type-1: the guest Vm runs directly over the host hardware, e.g. Xen, Hyper-V, VMware ESXi  

-> Type-2: the guest Vm runs over hardware through a host OS, e.g. Kvm, Oracle virtual box 

 

Ques37: Are Type-1 Hypervisors better in performance than Type-2 Hypervisors and Why? 

Ans: Yes the Type-1 Hypervisors are better in performance as compared to Type-2 hypervisors because 

Type-1 hypervisors does not run through a host OS, they utilize all resources directly from Host hardware. In 

cloud implementation Type-1 hypervisors are used rather than Type-2 because Cloud servers need to run 

multiple OS images and it should be noted that if OS images are run on host a OS as in case of Type-2, the 

resources will get wasted. 

 

Ques38: What is the function of Amazon Elastic Compute Cloud? 

Ans: Amazon Elastic compute cloud is also known as Amazon EC2 is an Amazon web service that provides 

scalable resources and makes the computing easier for developers. The main functions of Amazon EC2 are:  

- It provides easy configurable options and allow user to configure the capacity.  

- It provides the complete control of computing resources and let the user run the computing environment 

according to his requirements.  

- It provides a fast way to run the instances and quickly book the system hence reducing the overall time.  

- It provides scalability to the resources and changes its environment according to the requirement of the user.  

- It provides varieties of tools to the developers to build failure resilient applications. 

 



Ques39: What are the advantages of cloud architecture? 

Ans: Cloud architecture uses simple APIs to provide easily accessible services to the user through the internet 

medium. It provides scale on demand feature to increase the industrial strength. It provides the transparency 

between the machines so that users don't have to worry about their data. Users can just perform the 

functionality without even knowing the complex logics implemented in cloud architecture. It provides highest 

optimization and utilization in the cloud platform 

 

Ques40: What are the different components required by cloud architecture? 

Ans: There are 5 major components of cloud architecture.  

1. Cloud Ingress:  
Provides a mean to communicate with the outside world. This can be done with the help of communication 

methods such as:  

- Queue based communications  

- HTTP communications  

- REST/SOAP  

- Service Bus  

2. Processor Speed:  
Processor speed is the major section on which the whole cloud architecture is based. It provides on demand 

resources that can be dynamically allocated to the user. It saves lots of cost and has many benefits of 

virtualization.  

3. Cloud storage services:  
Cloud services provide means to store data to user's applications. It is used to provide services for different 

types of storages like: table data, files.  

4. Cloud provided services:  
Additional services are provided by the cloud, like data services, payment processing services, and search or 

web functionality services.  

5. Intra-Cloud communications:  

it provides a way to communicate with other systems that are using cloud architecture. Providers usually 

provide services so that one user can communicate easily with another user by being on cloud. 

Ques41: What is the relationship between SOA and cloud architecture? 
Ans: Service oriented architecture (SOA) is an architectural style that supports service oriented methodology 

that is being added in the cloud architecture as a mandatory component. Cloud architecture support the use of 

on-demand access to resources and it provides lots of other facilities that are being found in SOA as well. 

SOA makes these requirements optional to use. But, to get the full functionality and more performance based 

efficiency there is a requirement for the mixture of SOA and cloud architecture.  

Ques42: What does private cloud offer in building an infrastructure? 

Ans: Private cloud offers complete set of development tools and easy to configure panel where you can 

customize and deploy prototype applications.  

- It keeps the private sensitive application separate and hidden from the world.  

- It provides the provision to create high performance applications and include the concept of elasticity.  

- It uses a firewall and keeps all the resources in a pool that separates them with other resources that are made 

public. 

 



Ques43: What is cloud computing? 

Ans: The cloud computing is the computing which is completely based on the Internet. It can also be defined 

as the next stage in the evolution of the Internet. The cloud computing uses the cloud (Internet) that provides 

the way to deliver the services whenever and wherever the user of the cloud needs. Companies use the cloud 

computing to fulfill the needs of their customers, partners, and providers. The cloud computing includes 

vendors, partners, and business leaders as the three major contributors. The vendors are the one who provide 

applications and their related technology, infrastructure, hardware, and integration. 

The partners are those who offer cloud services demand and provide support service to the customers. The 

business leaders are the ones who use or evaluate the cloud service provided by the partners. The cloud 

computing enables the companies to treat their resources as a pool and not as independent resources. 

 

Ques44: What is a cloud? 

Ans: A cloud is a combination of hardware, networks, storage, services, and interfaces that helps in 

delivering computing as a service. It has broadly three users which are end user, business management user, 

and cloud service provider. The end user is the one who uses the services provided by the cloud. The business 

management user in the cloud takes the responsibility of the data and the services provided by the cloud. The 

cloud service provider is the one who takes care or is responsible for the maintenance of the IT assets of the 

cloud. The cloud acts as a common center for its users to fulfill their computing needs. 

 

Ques45: What are the basic characteristics of cloud computing? 

Ans: The four basic characteristics of cloud computing are given as follows: 

 Elasticity and scalability.  

 Self-service provisioning and automatic de-provisioning.  

 Standardized interfaces.  

 Billing self-service based usage model.  

Ques46: How many types of deployment models are used in cloud? 

Ans: There are 4 types of deployment models used in cloud: 

1. Public cloud  

2. Private cloud  

3. Community cloud  

4. Hybrid cloud  

Ques47: Which services are provided by Window Azure operating system? 

Ans: Windows Azure provides three core services which are given as follows: 

 Compute  

 Storage  

 Management  

 



Ques48:  What are the advantages of cloud services? 

Ans: Some of the advantages of cloud service are given as follows: 

 Helps in the utilization of investment in the corporate sector; and therefore, is cost saving.  

 Helps in the developing scalable and robust applications. Previously, the scaling took months, but 

now, scaling takes less time.  

 Helps in saving time in terms of deployment and maintenance.  

Ques49: What is Web Service? 

Ans: Web Services can convert your applications into Web-applications.Web Services are published, found, 

and used through the Web.The basic Web services platform is XML + HTTP. 

XML provides a language which can be used between different platforms and programming languages and 

still express complex messages and functions. 

The HTTP protocol is the most used Internet protocol. 

Web services platform elements: 

 SOAP (Simple Object Access Protocol) 

 UDDI (Universal Description, Discovery and Integration) 

 WSDL (Web Services Description Language) 

Ques50: What is UDDI? 

Anss: UDDI is an XML-based standard for describing, publishing, and finding Web services. 

 UDDI stands for Universal Description, Discovery and Integration. 

 UDDI is a specification for a distributed registry of Web services. 

 UDDI is platform independent, open framework. 

 UDDI can communicate via SOAP, CORBA, Java RMI Protocol. 

 UDDI uses WSDL to describe interfaces to web services. 

 UDDI is seen with SOAP and WSDL as one of the three foundation standards of web services. 

 UDDI is an open industry initiative enabling businesses to discover each other and define how they 

interact over the Internet. 

UDDI has two parts:  

 A registry of all a web service's metadata including a pointer to the WSDL description of a service 

 A set of WSDL port type definitions for manipulating and searching that registry 
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